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1 4 Surround Sound

n addition to creating a stereo mix of your project, you may also want to create a surround
sound mix. Surround sound is extensively used in movie soundtracks, as well as soundtracks
for games. And these days it is being used more and more for audio-only projects. You can
create your own surround sound music with the special surround mixing tools provided by
SONAR. From there, you can burn your music to CD or DVD and share it with others for
playback on any home theater system. In this chapter, you will learn the following:
B How to find the equipment you need for surround sound.
®  How to set up your studio for surround sound.
B How to set up a SONAR surround sound project.
B How to use the Surround Panner.

B How to add effects to a surround sound mix.

B How to export your surround project to an audio file.

Surround Sound Background Before reading the rest of this chapter, you may want to read
some background and overview information about surround sound. Check out the fol-
lowing resources:

Introduction to Surround Sound
www.digifreq.com/digifreq/article.asp?ID=21
Setting Up Your Studio for Surround Sound
www.digifreq.com/digifreq/article.asp?1D=22
Surround Sound Mixing Techniques
www.digifreq.com/digifreq/article.asp?ID=23
More Audio and Surround Articles

www.digifreq.com/digifreq/articles.asp
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Setting Up Your Studio

Working with surround sound isn’t just a simple matter of changing a few settings in SONAR
and, like magic, having a surround sound mix of your project. There are certain steps you need
to take in order to start working with surround sound. The first step will be to invest your
money in some new studio equipment, including a new sound card and new monitors (speakers).

Surround Sound Cards

I’m going to assume you’ll be working with a format of surround sound known as 5.1 Surround
Sound. There are many different surround sound formats, but 5.1 is the most common and is
used in audio for DVDs and video games, as well as DVD-A (DVD Audio) discs (special music-
only DVDs). As such, you will need a sound card that provides six separate mono audio outputs
(or three stereo outputs). If your card already provides this number of outputs or more, then
you’re all set in the sound card department.

If your card doesn’t provide at least six outputs, you’ll need to invest in a new card. You can get
both professional and prosumer cards from a number of different manufacturers. I usually rec-
ommend either Echo Audio (www.echoaudio.com) or M-Audio (www.m-audio.com). M-Audio
also sells a line of consumer-based cards that provide great sound. One such card is the Revo-
lution 7.1. This is a great card to use when you’re starting out with surround sound, and I’ll be
using it to demonstrate how to use SONAR’s surround features.

Revolution Review You can read my review of the Revolution 7.1 surround sound card
from M-Audio by going to:

www.digifreq.com/digifreq/reviewdetails.asp?ProdReview|D=24

Surround Sound Monitors

In addition to a multi-output sound card, you’ll need five matched monitors and a subwoofer (a
special monitor for playing low frequency audio, often called the Low Frequency Effects mon-
itor) to work in the 5.1 surround format. By matched monitors, I mean they should all be iden-
tical. For example, I have two KRK V4 monitors for creating stereo mixes in my studio. In order
to expand that for 5.1 surround, I would have to purchase three more V4 monitors. This is the
best way to go for a professional setup, but it can get very expensive.

You may want to ease your way into surround and get a prosumer monitor set up instead. 'm
currently using the Z-5500 Digital 5.1 5-Piece Speaker System from Logitech. The cost of the
system is about $250, but it provides everything you need to monitor in 5.1 surround. By every-
thing, I mean five monitors plus a subwoofer, six analog inputs, two digital inputs, a compu-
terized controller, and even a nifty remote control. On top of all that, it provides built-in Dolby
and DTS decoding. Go to www.digifreq.com/digifreq/newsinfo.asp?NewsID=2567 for more
information about the Logitech system.
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Surround Monitor Setup

Once you have your monitoring equipment, you’ll need to set it up. If you’re thinking you can
simply plop the speakers around your studio and get a good surround listening image, think
again. The five monitors need to be placed in a certain pattern around the room with equal
distance from your listening position; otherwise, you won’t get a clear indication of where the
musical elements are located in your mix during playback. Here’s how to do it:

1.  Place the center channel monitor dead center behind your mixing console or on top of
your computer monitor. When you sit down to mix your tracks, you should see the
center channel monitor centered right in front of you.

2. Get a microphone stand and place it in the same position where you will be sitting when
mixing your audio.

3. Use a tape measure to measure the distance from the microphone stand to the center
channel monitor.

4.  Get a roll of string and tie the free end of the string to the microphone stand. Unroll
the string, starting at the microphone stand and ending at the location of the center
channel monitor. Then cut the string. This marks the distance you will use to position
all of the other monitors.

5.  Get a compass (one that includes degree markings). At the microphone stand position,
point the compass at the center channel monitor. Then turn left so that the compass
reading changes 30 degrees.

6. Extend the string in that 30-degree direction. and now you have the location for your
left channel monitor.

7. Reposition the compass so that it points at the center channel monitor again. Then turn
30 degrees to the right and find the location for your right channel monitor.

8. To find the locations for the right and left surround monitors, follow the same
procedure with the compass and the string. This time, however, move 120 degrees
to the left and right to find the left and right surround monitor locations,
respectively.

When you’re done positioning the monitors, they should be placed at precise locations along an
imaginary circle, as shown in Figure 14.1. This is the standard 5.1 monitor positioning, accord-
ing to the SMPTE (Society of Motion Picture and Television Engineers) and ITU (International
Telecommunication Union) organizations. Since low frequencies are not directional, you can
place the LFE monitor anywhere on the floor. Mine is placed on the floor to one side of my
DAW (Digital Audio Workstation) desk.
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Figure 14.1 This is the standard 5.1 surround monitor positioning according to SMPTE and ITU.

Surround Monitor Calibration

Even after you’ve placed your monitors correctly, you’re still not quite finished with setting them
up. You also have to calibrate them. This means that you need to make sure they are all set to the
same volume level so that when you are mixing, you don’t get misled by how loud an audio
track may be playing when you pan it around the surround sound field.

You’ll need two things to calibrate your monitors: a pink noise source and an SPL (Sound Pres-
sure Level) meter. For pink noise, you can use a test tone CD, a tone generator, or even an audio
editor that includes a built-in noise generator. If you don’t have any of these, you can download
a pink noise audio file from www.5dot1l.com/downloads/pink_noise_44-1k.zip. For the SPL
meter, you’ll have to spend a few bucks, but you don’t need anything expensive. Many audio
engineers use basic meters that can be bought for about $50. Go to www.amazon.com/exec/
obidos/ASIN/B0002GWFG4/compmedia to check out the Galaxy Audio CM130 Checkmate
Sound Level SPL. Meter. Once you have these two items, you can calibrate your monitors by
doing the following;:

Monitor Connections Before you can calibrate your monitors, you need to connect
them to your sound card. Since there are many different sound cards and monitoring
systems on the market, | cannot walk you through this process. Read the documenta-
tion that came with your sound card and monitors. These documents should provide
you with all the information you need to properly connect your monitors to your sound
card.

1. Set your sound card output levels to 0 dB. For example, if you are using the M-Audio
Revolution, open its control panel. Then in the Output Mixer section of the panel, set
all the outputs to a volume level of 0 dB (see Figure 14.2). In addition, if your sound
card has a surround sound configuration option, be sure to set that as well. For this
example, set up your card for 5.1 surround sound.
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Figure 14.2 Set your sound card output levels to 0 dB.
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2. Change the settings on your SPL meter to Slow Scale and C weighting. Refer to the
documentation that came with your meter for explanations of these settings if you need

them.

3. Play pink noise through the left-front monitor.

Logitech Test Tone If you're using the Logitech Z-5500 Digital 5.1 5-Piece Speaker System
| mentioned earlier, you can use the built-in noise generator. Just press the Test button on
your remote control. The Logitech system will cycle noise through each of the monitors

automatically.

4. While sitting at your mix position, raise the SPL meter to ear level and point it at the

left-front monitor.
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5. Adjust the monitor volume so that the SPL meter reads 85 dB.

6. Repeat Steps 3 through 5 for each of the remaining monitors, except for the LFE
monitor.

7. Point the SPL meter at the LFE monitor and adjust the volume of the monitor so that the
meter reads 90 dB. The reading needs to be slightly higher because most SPL meters
don’t register low frequencies very well. The higher adjustment compensates for this
shortcoming.

Setting Up SONAR for Surround

When your studio configuration is complete, you’re ready to start working with surround sound
in SONAR. The first step in creating a surround sound project is to either open an existing
project file or create a new project. SONAR’s surround sound settings need to be configured
for each individual project that you create, but you can save your settings for use in multiple
projects if you’d like.

Surround Project Options
After you’ve either created a new project or opened an existing one, choose Options > Project >
Surround to open the Project Options — Surround dialog box (see Figure 14.3).

This dialog box is used to adjust the initial surround settings for your project. These settings
include the surround format, sound card outputs, bass management, and downmixing.

Surround Format

Even though I’ve been primarily talking about the 5.1 surround sound format, there are actually
many different formats available—even different 5.1 formats. SONAR provides support for
these multiple formats and includes preset options from which you can choose. When you
choose a surround format, what you are actually doing is specifying the number of monitors
that are in use, the position of those monitors, and how they are connected to your sound card.
With the Project Options — Surround dialog already open, use the Surround Format list to
choose a format (see Figure 14.4).

Notice that as you choose different formats, the diagram (shown to the right of the Surround
Format drop-down list) changes as well. This diagram displays the number of monitors required
for the chosen format. It also shows how those monitors should be positioned around your
mixing location. For demonstration purposes, I’ll be using the default format: 5.1 (SMPTE/ITU).

Surround Sound Card Outputs

After you’ve chosen a format, you also need to configure your sound card outputs so that
SONAR knows where to send the appropriate audio data to the monitors in your surround
setup. You do this by using the sound card output list in the top half of the Project Options
— Surround dialog box. This section of the box will list all of the monitors required to support
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Figure 14.3 Use the Project Options — Surround dialog box to adjust your project’s surround settings.

the surround format that you have chosen. For example, with the 5.1 (SMPTE/ITU) format
chosen, you’ll see six monitors listed by number (#) and name. To the right of each monitor
is a sound card output. To change the output for a monitor, click the down arrow to the
right of the output and choose a new one from the list (see Figure 14.5).

When using a sound card such as the M-Audio Revolution (which provides multiple stereo out-
puts with individual left/right settings), you’ll see the same sound card output listed twice, but
each will have a different number in parentheses next to it. For example, M-Audio Revolution 1/
2 (1) means that you are choosing the left channel of the first stereo output of the sound card.
The number in parentheses tells you if you’re choosing the left (1) or right (2) channel.
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Figure 14.4 Use the Surround Format drop-down list to choose a surround format for your project.

Bass Management

When your surround sound project is played on a home theater system, all the frequencies below
a certain point are routed to the LFE monitor (subwoofer). This is because the smaller monitors
that take care of the rest of the surround field are not large enough to reproduce very low fre-
quencies. Because of this, you need to listen to your project in the same way. The bass manage-
ment option provided by SONAR emulates the low frequency playback of a home theater
system.

To activate bass management for your project, put a check mark next to the Monitor with Bass
Management option in the Project Options — Surround dialog box. Then choose a cutoff point
(the point below which frequencies will be routed to the LFE sound card channel) from the
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Figure 14.5 Configure your sound card outputs in the Project Options — Surround dialog box.

Low-Pass Cutoff drop-down list. The standard for playback on a home theater system is 80Hz,
but there are other options available if you need them, as shown in Figure 14.6.

Surround Sound Bussing

One last thing you need to do before you can start mixing your project in surround sound is to
add at least one surround bus to your project. There are a number of different ways to add a
surround bus.

The Insert Menu
To add a surround bus to your project using the Insert menu, choose Insert > Surround Bus (see
Figure 14.7).
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Figure 14.6 You should monitor your project with bass management, so you can hear what it will
sound like when played by consumers.

The Bus Pane
You can also use the Bus pane in the Track view to add a new surround bus to your project. In
the Bus pane, right-click and choose Insert Surround Bus (see Figure 14.8).

Insert Send

An indirect way of adding a new surround bus to a project is to do it at the same time you are
inserting a new send into an existing track. Right-click an existing audio track and choose Insert
Send > New Surround Bus (see Figure 14.9).
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Figure 14.7 You can use the Insert menu to add a surround bus.

Insert Stereo Bus

Insert Surround

Figure 14.8 You can also add a surround bus via the Bus pane in the Track view.

Track Output

One last way to add a new surround bus to a project is simply to assign the output of an audio
track to a new bus. SONAR creates the new bus automatically. Just click the Output parameter
of the audio track and choose New Surround Bus (see Figure 14.10).
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Figure 14.9 Add a new surround bus at the same time you add a new audio track send.
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Figure 14.10 Assign the output of an audio track to a new surround bus.

Track Assignment If you don't use the track output method of creating a new surround
bus, then you will have to manually assign the output of your audio tracks to the new bus
or create a new bus for each track. You can also assign the output of your tracks to the
Surround Main, which is a virtual main output dedicated to surround sound in SONAR.
The Surround Main simply routes your audio directly to your sound card outputs as they
were assigned in the Project Options — Surround dialog box. The drawback to this
method is that you won't be able to assign any surround effects to your tracks. You
need to use a surround bus to utilize surround effects.
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Surround Sound Mixing

After you’ve created one or more surround buses for your project, you need to assign the outputs
of your audio tracks to those buses, if you haven’t done so already. When you assign the output
of an audio track to a surround bus, you’ll notice a number of changes made to the track. One
change is the display of the output meters. Instead of two channel meters, you’ll see multiple
channel meters. The number of meters depends on the surround format you’ve chosen and how
many channels exist in that format. For example, for the 5.1 (SMPTE/ITU) format, you will have
a six-channel meter, as shown in Figure 14.11.

Drums
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o0 |T| LFE  -IMF

0.0
~MianE-

Surround 2

Figure 14.11 SONAR provides multichannel output meters for audio tracks when mixing in surround.

Surround Sound Panning

Another change made to the audio track is the replacement of the usual Pan parameter with the
Surround Panner. Instead of simply panning between two stereo speakers, you can now pan your
audio track around a circular sound field between multiple speakers (the number of which
depends on the surround format you are using). The Surround Panner comes in a variety of
sizes, depending on where it is being accessed within SONAR.

The Micro Surround Panner
When working in surround, the normal Pan parameter of an audio track becomes the Micro
Surround Panner (see Figure 14.12).
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Figure 14.12 The normal Pan parameter of an audio track transforms into the Micro Surround Panner.
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By clicking and dragging within the Micro Surround Panner, you can change the surround pan-
ning location of your audio track. As you drag your mouse, you’ll notice the Surround Pan Angle
and Focus parameters being displayed and changed.

To the right of the Micro Surround Panner, you’ll see the LFE Send parameter. This parameter
determines how much of the signal from the current audio track you would like to send to the
LFE channel. This can come in handy if you want to dedicate an audio track for effects that
contain low frequency content like thunder claps and such.

The Small Surround Panner

If you add an aux send to an audio track that is routed to a surround bus, the send will provide a
Small Surround Panner, as shown in Figure 14.13. This works in a similar fashion as the Micro
Surround Panner and provides an LFE send, as well as a bus send level and pre/post parameter
like normal aux sends.
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00« LFE  -IMF

-Mane-
0O Suround 2

= Surround Main T
W PRE i  EOM™LFE  .IMF

Surround Pan Angle: 0.0 deq. Focus:

Figure 14.13 The Small Surround Panner is displayed on an aux send that is routed to a surround bus.

The Medium Surround Panner

As with the Micro Surround Panner, the Medium Surround Panner also replaces the normal Pan
parameter on an audio track, but in this case, the Medium Surround Panner is displayed in the
Track Inspector of the Track view and the audio channel strip for that track in the Console view
(see Figure 14.14).

The Medium Surround Panner works the same way as the previous Panners. Click and drag
within the Panner to pan your audio track in the surround field. The Medium Surround Panner
also provides an LFE send like the other Panner. One additional feature of the Medium Sur-
round Panner is the ability to mute individual monitors (speakers) in the surround field. You
will see these monitors represented within the Panner as small white boxes (see Figure 14.15).
Just click a box to mute that monitor. Click the box again to unmute the monitor.
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Figure 14.14 The Medium Surround Panner is displayed in the Track and Console views.

LFE Send -IMF

Figure 14.15 Mute monitors by clicking the small white boxes in the Medium Surround Panner.

Muting Monitors You can also mute monitors by right-clicking in the Panner and choosing
Mute [Name of Monitor]. This technique will also work with all the other Panners
mentioned.

The Large Surround Panner

To give you the most detailed access to the surround parameters for an audio track, SONAR
provides the Large Surround Panner (see Figure 14.16). To access the Large Surround Panner,
just double-click one of the other Panners or right-click one of the other Panners and choose
Open Surround Panner.
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Figure 14.16 The Large Surround Panner gives you detailed access to an audio track’s surround
parameters.

Changing Tracks Once open, you can change the track assignment for the Large Surround
Panner by clicking the track name bar located at the top of the window.

In the top portion of the Large Surround Panner window, you will see a circular graphic repre-
sentation of the surround sound field. Around this field, all the monitors are shown as small
white speaker symbols and positioned according to the surround format you have chosen. You
can click the speaker symbols to mute and unmute the appropriate monitors just like you can
with the Medium Surround Panner.

Inside the surround field, a small crosshair icon represents the pan position of the current track
in the surround sound field. As with the other Panners, you can simply click and drag your
mouse within the field to change the pan position. As you do this, you will see the crosshair
move, and you will also see the numerical values change in front of each monitor. These values
represent the volume (in dB) of the audio track within each of the monitors.
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In addition to the volume changes, you’ll notice some other parameters changing in the bottom
portion of the Large Surround Panner window. To change any of these parameters, just click
and drag your mouse over the appropriate slider. Drag left or right to make a change. Double-
click a parameter to return it to its default value. You can also type a new value by selecting the
parameter and pressing the Enter key.

These parameters represent the pan position of your audio track in the surround field, the stereo
width of your track, and the volume balance between the front and rear monitors of the sur-
round field. You’ll also find an LFE send parameter (just like with the other Panners) and an LFE
solo button, so you can quickly check only the sound coming from the LFE monitor.

Angle and Focus. The Angle and Focus parameters work together to designate the pan position
of the audio track in the surround field. This is the reason both parameters change when you
drag the crosshair around in the surround field. The Angle parameter designates the circular
position of the audio track panning within the surround field. You can set the Angle parameter
from —180 to 0 to +180 degrees. Notice that when you change the Angle parameter, the cross-
hair moves around in a circle within the surround field.

The Focus parameter designates how close the pan position of the audio track will be to the
center of the surround field. You can set the Focus parameter from 0 to 100. A setting of 0
will put the pan position at the exact center of the surround field. A setting of 100 will put
the pan position at the outer edge of the surround field (closest to the surrounding monitors).

Width. The Width parameter designates the width of the stereo audio track within the surround
field. In the surround field graphic, the width is represented by two green dots—one for the left
channel and one for the right channel of the stereo track. You can set the Width parameter from
0 to 360 degrees. The larger the value, the farther apart the stereo channels sound from one
another. The smaller the value, the closer they sound. For example, a value of 0 will essentially
make the track sound like a mono track because the stereo channels are right next to each other.
Using a value of zero, you can make the pan position of the track sound like it’s coming from a
single focused point in the surround field.

Front/Rear Balance (FrntRrBl). There may be times when you’ve found just the right pan position
for an audio track in the surround field, but you would like to change its overall volume as it
pertains to the front and rear monitors. This is where the Front/Rear Balance parameter (abbrevi-
ated as FrntRrBl in the Panner window) can be used. The value for this parameter ranges from
—100 to 0 to +100. The lower the value, the lower the volume of the front monitors. The higher
the value, the lower the value of the rear monitors. A value of 0 makes the front/rear volumes equal.

Surround Panning Scenarios
Just to give you a few examples of how you can position an audio track within the surround
field, I’'ll go through a few scenarios and show you what settings you need to achieve them.

Exact Center. To place your audio track in the exact center of the surround field, set the Angle,
Focus, Width, and FrntRrBl parameters to 0.
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Pinpoint Location. To place your audio track at an exact pinpoint location in the surround field,
set the Width and FrntRrBI parameters to 0. Now adjust the pan position by either changing the
Angle and Focus parameters manually or clicking and dragging your mouse in the surround field
graphic. This scenario also lets you make your audio track sound like it is coming directly from
one of the monitors in the surround field. To do this, set the Focus parameter to 100 and then
adjust the Angle parameter so that the pan position is exactly in front of the monitor from which
you want the audio track to be heard.

Front and Rear Stereo. To make your audio track sound like an ordinary stereo track coming
from the front monitors (see Figure 14.17), set the Angle parameter to 0, the Focus parameter to
100, and the FrntRrBl parameter to 0. Then adjust the Width parameter so that the two green
dots line up with the front left and right monitors. To do this with the rear monitors, just change
the Angle parameter to 180. Then adjust the Width so that the green dots line up with the rear
left and right monitors.

SONAR Audio and MIDI DEMOZ.cwb - Surround P...| |

Drumis Send: Surround Main

-IMF é

5.1 {(SMPTE/ITU}
Angle 0.0} Focus 100.0

Width E0.0) FrmtRrRl n.n

LFE Send -IMF | [BLFESalG

Figure 14.17 Creating an ordinary stereo sound for your audio track in the surround field.

Side Stereo. To make a stereo audio track sound like it is being played in stereo on the side of
the surround field (see Figure 14.18), set the Angle parameter to 90 to place the track on the
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Figure 14.18 Create a left or right stereo sound for your audio track in the surround field.

right of the field or set the parameter to —90 to place the track on the left side of the field. Set the
Focus parameter to 100 and the FrntRrBl parameter to 0. Then adjust the Width parameter to
your liking (a good setting is about 60).

Surround Automation and Grouping Automation and grouping for surround parameters
work the same as for any other parameter. Just right-click the parameter and choose
Automation Write Enable to designate the movements of that parameter for recording.
Then follow the steps outlined in Chapter 12 for recording automation. In addition, you
can arm all parameters for the Surround Panner at the same time by right-clicking the
surround field graphic.

For grouping, right-click the parameter and choose Group > [group letter] to group that
parameter. Then follow the instructions provided in Chapter 12 covering how to use
SONAR's grouping features.
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Surround Sound Effects

Working with effects in surround is similar to that of stereo, except in surround you’re dealing
with multiple channels rather than just two. You can apply effects evenly to all surround chan-
nels, or you can apply an effect to a single surround channel. The only caveat is that you must
apply surround effects to a surround bus. Surround effects cannot be applied to an audio track
without using a surround bus. Because of this, there will probably be many times where you will
want to assign a new surround bus to each of your audio tracks so that you can apply different
effects to each track.

To apply an effect to a surround bus, you simply follow the same procedure as applying an effect
to a stereo bus. Just right-click in the Fx bin of the surround bus and choose the effect you would
like to apply.

Dedicated Surround Effects

SONAR provides two dedicated surround effects for use in your projects: the Sonitus Surround
Compressor and the Lexicon Pantheon Surround Reverb. Both of these effects are based on their
stereo versions. Be sure to read through that material (Chapter 11) in order to learn how to use
these effects. There are a few basic differences, though, and I will explain those here.

Sonitus Surround Compressor

The Sonitus Surround Compressor provides four separate compressor effects in one. Each effect
provides the same parameters. The difference between the surround and the stereo versions
comes into play when you are assigning the surround channels to each of the four compressor
effects provided. When you open the Surround Compressor, you will see four compressor select
buttons located at the top of the dialog box (see Figure 14.19). Initially, all the surround chan-
nels are assigned to the same compressor. You can leave them this way if you want. This will let
you apply the same compression effect to all the surround channels.

|I Bypass J! Unda Jl Setup A |"” Feset JlP‘resets vI Help
) W ——
Threshold Threshold

Threshold
Bypazz || 00 4 |E_I,Ipa$$|| 00 gg | 00 gg

Figure 14.19 The Sonitus Surround Compressor provides four compression effects.

To assign a surround channel to a different compressor effect, click the down arrow next to one
of the effects and choose the surround channel(s) you want to use (see Figure 14.20).

You’ll notice that each effect is given its own color. From left to right there is red, blue, green,
and orange. When you assign a surround channel to a different effect, its input controls and its
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Figure 14.20 Use the down arrow next to an effect to assign its surround channels.

compression graph take on those colors. This lets you tell at a glance to what effect your sur-
round channels are assigned.

Other than those differences, the Sonitus Surround Compressor works the same way as the
stereo version. The surround version provides some presets from which you can learn. Just
click the Presets button at the top of the dialog box and choose a preset from the list.

Lexicon Pantheon Surround Reverb

Like the Sonitus Surround Compressor, the Lexicon Pantheon Surround Reverb (see Figure 14.21)
works in almost the same way as the Lexicon Pantheon Stereo Reverb. There are a few exceptions
when it comes to the number of adjustable parameters provided.
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Figure 14.21 The Lexicon Pantheon Surround Reverb provides additional parameters for controlling
reverberation in a surround environment.

The Surround Reverb provides Front Level and Rear Level parameters, which control the vol-
ume of the effect in the front and rear monitors independently. There are also F (Front) Rolloff
and R (Rear) Rolloff parameters. In addition, there are echo sections in the Reverb dialog box
for both the front and rear.

Using Stereo Effects in Surround

If SONAR simply provided two surround effects out of its entire arsenal, it wouldn’t provide
much power, would it? Even though there are only two dedicated surround effects included with
SONAR, you can actually use all of SONAR’s effects in your surround projects using some
special built-in features.
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When you assign a stereo effect (mono effects work, too) to a surround bus, SONAR automat-
ically creates multiple instances of that effect for each of the surround channels you are using.
For example, when using the 5.1 surround format, SONAR will assign the front left and right
channels to the left and right channels of the first stereo effect, the rear left and right channels to
the left and right channels of the second stereo effect, the center channel to the left channel of the
third stereo effect, and the LFE channel to the left channel of the fourth stereo effect. All of these
controls are available in a single effect window, as shown in Figure 14.22.
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SHELF TRIM

ECE
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LR HOOR (=000 0 808 | O
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Figure 14.22 One effect window holds multiple instances of the effect to provide for all the surround
channels.

Each effect instance can be accessed by clicking the appropriate tab at the top of the effect win-
dow. All the controls for each instance are identical, and the effect works just like its stereo
version. In addition, all of the parameters for each instance are linked by default. This means
that if you change a parameter on one instance, that same parameter will change on all the other
instances. Having the parameters linked makes it easy to be sure the effect sounds the same on all
the surround channels.
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If you want to have the effect sound different on certain surround channels, you can unlink the
parameters for each instance. First, click the tab for the effect instance you would like to change;
then click the Unlink Automation Controls button at the top-right of the effect window (see
Figure 14.23). Now the parameters for that instance can be changed, and the equivalent param-
eters in the other instances will remain the same.

Inlink, Awktomation Controls '

Figure 14.23 Click the Unlink Automation Controls button to change the parameters for one instance
and not the others.

As far as the effect parameters themselves, they work exactly the same as their stereo versions.

The Surround Bridge

One other thing that makes using stereo effects in a surround project unique is SONAR’s Sur-
round Bridge feature. This is actually the feature that uses stereo effects in surround and auto-
matically creates the multiple effects instances when you apply an effect to a surround bus. But
there may be times when you want to change the order of the effect instances and assign the
instances to different surround channels. You can do this by clicking the Surround Bridge tab in
the effect window (see Figure 14.24).

Under the Surround Bridge tab, you’ll see the Plug-in Instance Configuration section showing
how each of the effect instances is configured. The number of the instance is shown in the first
column. The second column shows which surround channel is assigned to the left input of the
instance. The third column shows which surround channel is assigned to the right input of the
instance. To change a channel assignment, just click the down arrow next to the channel and
make a new choice (see Figure 14.25). For example, you may want each surround channel to
have its own effect instance. You would simply click the left channel input of a blank effect
instance and assign it to a surround channel. This would remove the surround channel’s current
instance assignment and create a new instance tab at the top of the window for the new surround
channel assignment.

You can also quickly link or unlink all the controls in an effect instance by adding or removing
its check mark in the column labeled Controls Linked to Group. In addition, if you want to
disable an effect instance, just remove its check mark in the Enable column. Add the check
mark to enable the instance again.

One last feature of the Surround Bridge is the Unlinked Controls section. When you select an
effect instance in the Plug-in Instance Configuration section, the Unlinked Controls section lists



*gajendra* D:/Thomson_Learning_Projects/Garrigus_163132/z_production/z_3B2_3D_files/Garrigus_163132_ch14.3d, 14/11/08/16:24:8, 16:24, page: 591

Chapter 14 Surround Sound 591

= Cakewalk FxEq [Surround 3] - SOMAR Audio and MIDI DEMO2.cwb [._] = E
E=d [

L/R | srRs] © | LFE

Flug-in Instance Configuration

Plug-in# | Left Input Right Input Controls Linked to Group | Enable
1 Left ~ Right - T o
2 Left Suround ™ Right Surround . ™ o ¥
3 Center v - I T
4 LFE - - T o
5 w w
E - -

Unlinked Controls
Plug-in# | Cantral Name Relink Contrals

Figure 14.24 Click the Surround Bridge tab to access the Surround Bridge settings.

all unlinked controls for that instance. You can relink any of the listed controls by clicking the
control to select it and then clicking the Relink Controls button.

Exporting Your Surround Project

After you’ve added effects and mixed your tracks into a superb, surround masterpiece, you can
use SONAR’s export features to save your project as a multichannel audio file, which can then
be burned to CD or DVD. Before exporting, however, be sure to check the downmix of your
project.

Downmixing

When mixing a project in surround sound, you should always keep in the back of your mind the
fact that your surround mix might be heard in stereo at one time or another. The reason for this
is that listeners could select the stereo mode on their home theater systems when playing your
music. If they do this, the home theater system automatically mixes the six surround channels (in
a 5.1 surround mix) down to the two stereo channels. The center surround channel is added
to the left and right stereo channels equally. The left and right surround channels are also added
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Figure 14.25 Change surround channel effect instance assignments with a simple click.

to the left and right stereo channels. And the LFE channel is either added or, in some instances,
just removed. Because of this, you should always listen to your surround mix in stereo when
you’re finished. Here’s how to check the downmix of your surround project:

1. If you don’t have one, insert a stereo bus into your project by right-clicking in the Bus
pane and choosing Insert Stereo Bus.

2. For every surround bus that you have in your project, assign its output to the new stereo
bus.

3. Choose Options > Project > Surround to open the Project Options — Surround dialog
box (see Figure 14.26).

4. In the Downmixing section, choose the volume levels (in dB) at which you want the
center channel, surround channels, and LFE channel mixed into the left and right stereo
channels. The default settings usually work well, but every project is different, so you’ll
have to try the different settings to see which ones work with your project.
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Figure 14.26 Use the Project Options—Surround dialog box to set your project’s downmixing parameters.

Configurable Downmixing Settings Even though SONAR provides a number of default
downmixing values from which to choose, you can actually type any dB level into the
downmixing parameters that you would like. Just click inside a parameter and type in a
new value.

5. Click OK.

6. Listen to your project through the new stereo bus. If it doesn’t sound quite right, either
adjust your mix or adjust the downmixing settings.
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When you’ve got the right mix, you can export your project to a stereo file if you’d like,
and SONAR will take into account your downmixing settings.

After you’ve finished downmixing, you can set your surround bus outputs back to their original

values.

Exporting to Multichannel WAV or WMA
To let others hear your surround project, SONAR exports your project to a multichannel WAV
file or Windows Media File. Here is how it’s done:

1.

10.

11.

Choose Edit > Select > None to make sure no tracks are selected if you want to export
the entire project. Choose File > Export > Audio to open the Export Audio dialog box
(see Figure 14.27).

Set the Look In parameter to the folder on your hard drive in which you would like to
save your file.

Type in a File Name for the file.

Select a Files of Type for your file. If you plan on burning your project to DVD in the
DVD-Audio or DVD-Video formats, export it as a WAV file by choosing the RIFF
Wave format. If your project will be played using the Windows Media Player, you can
export it as a Windows Media File by choosing the Windows Media Advanced
Streaming Format.

More than likely, you have your surround buses all being output to the Surround Main
(otherwise you wouldn’t be able to mix in surround). So set the Source Category to
Main Outputs.

Select Surround Main in the Source Buses/Tracks list.
Choose Multichannel for the Channel Format.

Depending on what you used for your project sampling rate, set the Sampling Rate to
that same value here. You can use a sampling rate up to 96,000 for 5.1 surround in the
DVD-Audio format.

Depending on what you used for your project bit depth, set the Bit Depth to that same value
here. You can use a bit depth up to 24-bit for 5.1 surround in the DVD-Audio format.

In order to make sure all your automation and effects are included in your exported file,
be sure to put check marks next to all the options in the Mix Enables section.

Click Export. If you chose the RIFF Wave format for your file, then SONAR will export
the file, and you are now finished. If you chose the Windows Media Advanced
Streaming Format file, there are some additional steps.
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Figure 14.27 Use the Export Audio dialog box to save your project as a multichannel audio file.

12.  After you click Export, SONAR will display the Windows Media Format Encode
Options dialog box (see Figure 14.28).
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Figure 14.28 Use the Windows Media Format Encode Options dialog box to save your surround project
as a Windows Media File.

13.

14.

15.

16.

Enter the information for your project in the Title, Author, Rating, Copyright, and
Description fields. The Windows Media Player will display this information for your
listeners.

Add or remove the check mark next to the Variable Bit Rate option. Activating this
option tells SONAR to vary the bit rate during the encoding process. Sometimes this
can yield a higher quality sound and a smaller file size, but it depends on the material
you are encoding. In addition, activating this option affects the selections available from
the Codec and Format parameters.

With the Variable Bit Rate option activated, you can choose between Windows Media
Audio 9 Professional and Windows Media Audio 9 Lossless for the Codec parameter.
The Lossless option means that there will be no quality loss in your encoded file, but
choosing this option gives you only one choice for the Format parameter.

With the Variable Bit Rate option activated, you can choose three different options for
the Format parameter. Each option begins with the text VBR Quality. The higher the
quality number, the higher the quality of your encoded audio, but the larger the file will
be. With the Variable Bit Rate option deactivated, you can choose from a large variety
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of options for the Format parameter. The higher the kbps rating you choose, the higher
the quality of your encoded audio, but the larger the file will be.

17.  Click OK.

After SONAR encodes your file, you can take it and burn it to CD or DVD for sharing with
others.

Encoding and Burning

The two most common forms of distributing a 5.1 surround mix are on DVD in either the DVD-
A (DVD-Audio) format or the DVD-V (DVD-Video) format. Unfortunately, SONAR doesn’t
provide the features for creating DVD-A or DVD-V discs. There’s a reason for this—it would
add a lot of extra cost to the software, and with so many different choices on the market, users
are better off being able to make their own choices as to what they need for DVD-A or DVD-V
software.

I’m not going to go into the encoding process because each product is different, and there’s no
way to cover them all. However, you can find more information about creating DVD-A and
DVD-V discs at the following resources:

B Encoding and Recording Your Surround Sound Mix to Disc—www.digifreq.com/digifreq/
article.asp?ID=24

B More audio and surround sound articles—www.digifreq.com/digifreq/articles.asp
B 5dotl.com—www.5dotl.com

B Everything You Wanted to Know about DVD-Audio—www.discwelder.com/pdfs/
dvdAudioWhitepaper.pdf

B DVD Authoring—www.discwelder.com/pdfs/dvdr_whitepaper.pdf
B Dolby Digital Guidelines—www.minnetonkaaudio.com/pdfs/Dolby%20Digital %20
Guidelines.pdf

Good luck in creating your very own surround sound projects using SONAR! Remember to
experiment since mixing in surround gives you so much more flexibility than mixing in plain
old stereo does.
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